Microsoft OneNote Training

IT ESSENTIALS – An Introduction to OneNote 2013 (IS962)

October 2015

Book online at: Royalholloway.ac.uk/it/training
Self-Study packs also available
Table of Contents

FILES REQUIRED AND INTRODUCTION ............................................................. 2
STARTING OUTLOOK IN A PC LAB .................................................................. 3
STARTING ONENOTE 2013 ............................................................................. 4
CREATING A ONENOTE NOTEBOOK ............................................................... 5
MAIN PARTS OF THE ONENOTE SCREEN .................................................... 6
WORKING WITH PAGES AND SECTIONS ....................................................... 7
ADDING SECTIONS .......................................................................................... 8
CHANGING THE COLOUR OF SECTIONS ....................................................... 9
ADDING BASIC TEXT TO A PAGE ................................................................ 10
FORMATTING NOTE CONTainers’ TEXT ....................................................... 11
MOVING AND JOINING NOTE CONTainers ................................................... 12
INSERTING PICTURES INTO A NOTEBOOK PAGE ......................................... 13
CAPTURING IMAGES USING SCREEN CLIPPING ........................................... 14
EXTRACTING TEXT FROM IMAGES ............................................................... 15
INSERTING IE, WORD OR POWERPOINTER CONTENT (1) .......................... 16
INSERTING IE, WORD OR POWERPOINTER CONTENT (2) ......................... 17
CREATING LINKS BETWEEN ONENOTE PAGES .......................................... 18
CREATING LINKS BETWEEN A PARAGRAPH AND PAGE ............................ 19
RENAMING LINKS ........................................................................................... 20
ADDING NEW PAGES .................................................................................... 21
SEARCHING WITHIN THE NOTEBOOK (1) ................................................... 22
SEARCHING WITHIN THE NOTEBOOK (2) ................................................... 23
ADDING AND USING TAGS (1) .................................................................... 24
ADDING AND USING TAGS (2) .................................................................... 25
ADDING TO DO TAGS .................................................................................... 26
USING HANDWRITING TO ENTER NOTES .................................................... 27
SHARING ONENOTE NOTEBOOKS (1) ......................................................... 28
SHARING ONENOTE NOTEBOOKS (2) ......................................................... 29
SHARING ONENOTE NOTEBOOKS (3) ......................................................... 30
BACKING UP YOUR ONENOTE NOTEBOOKS ............................................ 31
PASSWORD PROTECTING A SECTION ............................................................ 32
UNLOCKING A PASSWORD PROTECTED SECTION ..................................... 33
E-MAILING A PDF COPY OF A ONENOTE NOTEBOOK (1) ......................... 34
E-MAILING A PDF COPY OF A ONENOTE NOTEBOOK (2) ......................... 35
SENDING ONENOTE PAGES AS AN OUTLOOK E-MAIL ............................. 36
INSERTING DETAILS FROM OUTLOOK MEETINGS/APPTS ....................... 37
INSERTING LINKS TO OUTLOOK MEETINGS/APPTS (1) ............................ 38
INSERTING LINKS TO OUTLOOK MEETINGS/APPTS (2) ............................ 39
CREATING AN OUTLOOK TASK FROM ONENOTE CONTENT .................... 40
CLOSING & OPENING ONENOTE NOTEBOOKS ......................................... 41
COPYING EXISTING NOTES TO ONENOTE (1) ........................................... 42
COPYING EXISTING NOTES TO ONENOTE (2) ........................................... 43
ACCESSING THE IT TRAINING EXERCISE FILES FROM YOUR OWN PC/LAPTOP ................................................................. 44

These session notes are available in alternative formats on request.
For further information please contact Chris Horton in Computer Centre Room 102
(01784 41 4025, c.horton@rhul.ac.uk)

© Royal Holloway and Bedford New College 2015. All Rights Reserved
# Files Required and Introduction

## Files Required

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Founders North Tower.jpg</td>
<td>R:\IT Training\Images\Founders North Tower.jpg</td>
</tr>
<tr>
<td>Presentations.pptx</td>
<td>R:\IT Training\Demos\Presentations.pptx</td>
</tr>
</tbody>
</table>

The (R:) drive, from which this file can be accessed, is available on all Open Access PCs. This can also be mapped on your own computer; details are given on the back page.

## Introduction

This session shows how you can use a range of OneNote’s many features to manage the notes you keep.

The session includes how to:
- Find your way around OneNote
- Work with OneNote’s Sections and Pages
- Enter and modify content onto OneNote’s pages
- Insert webpages, Word documents, and PowerPoint presentations
- Create links between OneNote pages and paragraphs
- Work between OneNote and Outlook
- Locate particular notes using the Search and Tags facilities

OneNote is included as part of Office 2013
It is also available for:
- Later Windows phones and tablets
- Apple Mac OS X (10.9 and higher)
- Later iPad and iPhones (free for 500 notes)
- Later Android tablets and mobiles (free for 500 notes)

OneNote includes the fundamental ability to share Notebooks. When doing this you can:
- Simultaneously work across other computers and mobile devices (laptops, iPad, smartphone etc.) that you own
- Share the Notebook with others, e.g. by using your OneDrive (formally SkyDrive) which is cloud (web) based and part of your e-mail account

In this session we will concentrate on using a non-shared Notebook, but information on how to share Notebooks is also included.
ST962 – Introduction to OneNote 2013

STARTING OUTLOOK IN A PC LAB

As OneNote includes the facility to work with Outlook, we will need to have this open for the later part of the session.

In the PC Labs Outlook is accessed by navigating through the All Programs folder.

Follow these steps:

1. To be able to use the features within OneNote that are dependent on Outlook, e.g. inserting details from Outlook meetings, it is important that Outlook is opened **before** opening OneNote.
   If this is not done the buttons on OneNote’s Ribbon that enable this connectivity will fail to display.

2. To begin opening Outlook, click on the **Start** button at the bottom-left of the Screen.

3. Then click on **All Programs** at the bottom of the menu that displays.

4. Click on **Current Applications** from the menu that displays.

5. Click on **Microsoft Office**.
   Then click on **Outlook 2013**.

6. Outlook will run through a series of setup dialogue boxes to enable you to access your e-mail account.

7. When prompted for your password enter it into the dialogue box that displays.

8. When the **Finish** button displays at the bottom right-hand corner of the setup dialogue box click on it to complete the setting up.

9. Outlook will then display and once it has completed loading, which may take several minutes, you can use it.
STARTING OneNote 2013

OneNote is included as part of Office 2013, and so you will find it in the Microsoft Office 2013 or Office 2013 folder.

Follow these steps:

1. To open OneNote on a PC running Windows 7: Begin by clicking on the Start button at the bottom left of the screen.
2. Click on All Programs.
3. If using a PC Lab PC click on Current Applications.
4. Click on the Microsoft Office 2013 yellow folder to display its contents.
5. Click on OneNote 2013.
CREATING A ONE NOTE NOTEBOOK

OneNote saves your notes in what it calls a Notebook. Each Notebook can contain multiple pages, and these can be broken into Sections. These Sections enable similar or related notes to be kept together.

The ability to include a number of Sections in a Notebook means that, for example, non-related notes can be kept in the same Notebook.

Follow these steps:

1. Before starting ensure that the Ribbon is expanded, and so showing its buttons (see screen capture on next page). To expand a collapsed Ribbon click on the Ribbon Display Options button at the top right of the window (see illustration below), then click on Show Tabs and Commands.

2. To begin creating a OneNote Notebook, click on File at the left of the Ribbon. Click on New.

In this case we will save this Notebook to our (Y:) drive:

Click on the Computer button.

Note: The OneDrive @ Royal Holloway option enables you to save the Notebook to your College OneDrive account. Doing this enables you to access the Notebook from different computers, laptops, and tablets, including iPads, and to share it with others.

Click within the panel below the Notebook Name: heading at the centre right of the window.

Enter a suitable name for this notebook, which in this case is: First OneNote Notebook

To set this up so that it saves to your (Y:) drive:

Click on the Create in a different folder link towards the bottom right of the window.

If necessary scroll down in the left-hand panel of the Create New Notebook dialogue box to display the list of drives available. Click on the (Y:) drive in the list to display its contents in the right-hand panel.

If you wish to save the Notebook to a folder within your (Y:) drive click on it in the right-hand panel.

Click on the Create button at the bottom right of the dialogue box to select the drive and create the Notebook.
Main Parts of the OneNote Screen

- OneNote Notebook (File)
- Sections Tabs (Jobs tab selected)
- Display other Notebooks Button
- New Section Button
- Display Notes Area as Full Page
- New Page Button
- Page Tabs Panel
- A page within the Jobs Section
- Notes Area
- Sections Tabs
- New Page Button
- A page within the Jobs Section
- Page Tabs Panel
- Display Notes Area as Full Page
- New Section Button
- Display other Notebooks Button
- Sections Tabs (Jobs tab selected)
- OneNote Notebook (File)
WORKING WITH PAGES AND SECTIONS

When a Notebook is first created it includes one page, titled **Untitled page**. This is contained within a Section called **New Section 1**.

Each page can be extremely long, as by default it is not constrained to the usual A4 paper size. You can create a large number of Sections, and each can contain a significant number of pages.

Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will now begin creating a **To Do List** by adding a page title and renaming **Section 1**.
2. To begin, click within the Title panel at the top of the page. Enter the page title, which in this case is: **To Do List**.
3. Notice that the page name has changed in the right-hand **Page Tabs panel** from **Untitled page** to **To Do List**.
   You should see from this that the page title is used as both the page heading and page name.
4. Now change the name of the **New Section 1** Section to **Jobs**:
   Double click on the text in the **New Section 1** tab so that the text becomes highlighted.
5. Overtype the text with its new Section name, which in this case is: **Jobs**.
   Press **[Enter]** on the keyboard to accept the change.
6. It is useful to note that OneNote saves your work as you progress. Therefore, there is no necessity to ever manually save your Notebook once it has been created – it is all done for you automatically!
**ADDITION SECTIONS**

Sections can be easily added to a Notebook. This enables you to include, for example, a Section for each topic included in the Notebook. As each Section can contain a large number of Pages, this provides a lot of flexibility on how the Notebook can be used.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.
   We will now add a Section to record the minutes from any meeting we attend.

2. To create the Section click on the **New Section** (plus sign) button to the right of the **Jobs** section tab.

   A new Section tab is added, and given the name New Section 1.
   Without clicking anywhere overtype this name with the one we wish to use: **Minutes**
   Press **[Enter]** on the keyboard to accept the change.

   **Note:** If the Section name is not already selected, double-click on it to highlight it in blue, then overtype the name with the one you require.

3. Now enter the page’s heading:
   Click within the **Title panel** at the top of the page.

4. Enter the page title, which in this case is: **Minutes for Meetings**
   **Note:** The order of the Sections’ tabs can be changed by clicking on one of the tabs and dragging it to the left or right as required.
   As you do this a black down-facing triangle indicates where the tab will be positioned when the mouse button is released.
CHANGING THE COLOUR OF SECTIONS

To help identify the different Sections within your Notebook you can change the colour to one of your choice.

Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will now change the colour of the **Minutes** Section to be purple.
2. To begin, right-click on the **Minutes** Section tab.
3. Select **Section Color** from the bottom of the menu that displays.
4. Select **Purple Mist** (or another colour of your choice) from the submenu that displays.
5. You should notice that both the **Minutes** Section tab and the **Add Page** button on the right of screen now display in Purple Mist (or the colour you chose), and the rest of the **Page Tabs** panel displays with a pastel shade of the colour.
**ADDING BASIC TEXT TO A PAGE**

Notebooks use grey text boxes, called Note Containers, for the text-based content on the pages. As a result, to enter content you just need to click anywhere on the page and then type.

Remember, each page can be extremely long, as, by default, they are not constrained to the more usual A4 paper size.

---

**Follow these steps:**

1. Before beginning ensure that you have completed the previous page. We will now create a To Do list within the Jobs Section. We will do this by adding a Note Container for a subheading, and then another for the actual list.

2. To begin, click on the Jobs Section tab above the Notes area.

3. Then click anywhere below the page title to display an insertion point. Enter the subheading, which in this case is: **Current To Do List**

4. Now create another Note Container to contain the actual list: Click anywhere to the right and below the Current To Do List subheading.

5. **Note:** Clicking immediately below the Current To Do List subheading is likely to just extend its Note Container, not create another one.

6. Now enter the three items of the To Do List:
   - Type: **Complete Notes**
   - Press [Enter] on the Keyboard
   - Type: **Order Supplies**
   - Press [Enter] on the Keyboard
   - Type: **Arrange Meeting**

   It should be noted that content can also be Pasted into a OneNote page by using the same methods as used in Word.

7. When doing this, if the cursor is within an existing Note Container the Pasted content will be added to it. If the cursor is on a blank area of the page a new Note Container will be created and the Pasted content inserted into it.
FORMATTING NOTE CONTAINERS’ TEXT
Text in the grey Note Containers can be formatted in a similar way to when using Word.

Indeed, many of the options on OneNote’s Home tab at the left of the Ribbon are the same as on Word.

Follow these steps:

1. Before starting ensure you have completed the previous page.
2. We will now format the Current To Do List subheading to be bold, and the actual To Do List to be a bulleted list.
3. To begin, click and drag across the Current To Do List subheading to select it.
4. Ensure that the Home tab at the left of the Ribbon is selected. Then click on the Bold button in the Basic Text group towards the left of the Ribbon.
5. To now make the actual list a bulleted list: Click and drag from Complete down to Meeting to select the entire list.
6. Click on the Bullets button towards the top right of the Basic Text group towards the left of the Ribbon.
MOVING AND JOINING NOTE CONTAINERS

OneNote’s ability to enter text into any location on the page can be really useful when taking or creating notes. As part of this, you can easily move the Note Containers around the page, for example so that they are alongside other relevant notes. You can also join notes together, for example to make them more coherent.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.
2. Note Containers can be easily moved to any location on the page by just dragging them to the required position.
3. To demonstrate this, click on the bulleted To Do List so that it displays its border.
4. Point to its wide top border, so that the cursor changed to a four-headed arrow.
5. Then click and drag the Note Container to where on the page you want it.

       Note Containers can also be joined together.
6. To demonstrate this, we will join the Current To Do List subheading with the bulleted To Do List so that they display within one Note Container.
7. To begin click within the Current To Do List subheading so that it displays a grey right-facing pointer to the left of its Note Container.

       Click on the grey right-facing pointer and then drag it towards the bulleted To Do List. When the subheading appears within the Bulleted To Do List’s Note Connector, and is aligned to the left of the list release the mouse button.
8. You should note that the Current To Do List subheading can be inserted into a variety of positions within the bulleted List’s Note Connector, including as a right-aligned heading and within the actual list.
INSERTING PICTURES INTO A NOTEBOOK PAGE

When wishing to insert a picture into a Notebook it can be either Pasted in or Inserted from the Insert tab on the Ribbon.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.
2. To investigate how the Insert method is used for adding pictures to a Notebook we will now add an image of Founder’s North Tower to our current page.
3. To begin, click on the page where you want the image to display. In this case click anywhere below the Current To Do List.
4. Click on the Insert tab towards the left of the Ribbon. Click on Pictures in the Images group towards the left of the Ribbon.
5. When the Insert Picture dialogue box displays:
   a. If necessary scroll down in the left-hand panel to display the list of available drives.
6. Click on the (R:) drive in the list to display its content in the right-hand panel.
   b. In the right-hand panel double-click on the IT Training folder.
7. Then double-click on the Images folder, which is where the image is located. Double-click on Founders North Tower to insert the image onto the page.
8. Once the image is inserted onto the page you can drag it to a different location if required, by first clicking on it so that its border displays.
   a. The image can also be resized by clicking on it so that its border displays.
   b. Then dragging the Sizing Handles at its corners and centre points, so that it is the required size.
CAPTURING IMAGES USING SCREEN CLIPPING

In addition to being able to Paste and Insert images into OneNote you can also use the Screen Clipping tool. This enables a selected part of a screen to be captured and automatically added to a Notebook.

When using this, it is important to display the area to be captured immediately before enabling Screen Clipping.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.
   We will now consider how Screen Clipping can be used to capture the orange panel of text towards the top left of the College homepage.

   To begin, click on the Minutes Section tab.

2. Then click where the image is to appear, which in this case is anywhere below the Minutes for Meetings page heading.

3. When using the Screen Clipping tool you need to display the area (webpage, document etc.) immediately before enabling Screen Clipping.

   Therefore, now open Internet Explorer (or any other web browser). To do this in a PC Lab:

   Click on Start at the bottom left of the screen.

   Click on Internet Explorer.

   Ensure that the College homepage displays.

4. To now enable Screen Clipping:
   Display OneNote by clicking on its button on the Taskbar.

5. Click on the Insert tab towards the left of the Ribbon.

6. Click on Screen Clipping in the Images group towards the left of the Ribbon.
   OneNote will minimise to enable a dimmed-out view of the College homepage to display.

7. Click at the top left of the large orange text area at the top of the webpage.

   Then drag down and across to its right corner to select just the orange area.

   As you do this the selected area will display with proper colouring etc.

8. When the mouse button is released OneNote redisplays, and the captured area inserted into the page.

   **Note:** If using Internet Explorer the captured area’s URL will be included below the image.
   This does not appear to work with other browsers, e.g. Firefox.
**EXTRACTING TEXT FROM IMAGES**

OneNote includes a facility to extract the text content from graphics. When using this, the text is saved to the Clipboard as plain text, and so can be edited once pasted into OneNote.

**Follow these steps:**

1. Before beginning ensure that you have completed the previous page.
   We will now examine how OneNote can extract text from a graphic.
   In this case we will do this using the orange text box that we obtained via the Screen Clipping tool.

2. To begin, click on the orange text box that was inserted using Screen Clipping (see previous page).

3. Then right-click on the orange text box.

4. Select **Copy Text from Picture** from the menu that displays.
   The text will be copied to the Clipboard.

5. To now insert this text onto the page:
   Click anywhere on the page that is away from the orange text box.

6. Click on the **Home** tab at the left of the **Ribbon**.

7. Click on **Paste** in the **Clipboard** group at the left of the **Ribbon**.

   The text will be Pasted into its own Text Container ready for it to be edited.

   **Note:** Remember to **carefully** proofread the resultant text, in case the extraction process has introduced errors.

   On occasions this feature may produce very poor results or none at all.
   Should this happen it could be worth trying the Screen Clipping feature (see previous page) to take a capture of the graphic.

   You can then paste this into OneNote and then try the Extracting Text feature again.
   If doing this, Screen Clipping will need to be turned on by pressing the **Windows** key at the bottom left of the keyboard and with it depressed pressing **[s]** on the keyboard.
   When the capture has been taken Paste the text into OneNote by clicking on the [**Copy to Clipboard**] button at the bottom of the **Select Location in OneNote** dialogue box.
**INSERTING IE, WORD OR POWERPOINT CONTENT (1)**

Webpages (using Internet Explorer only), documents from Word, or presentation slides from PowerPoint can be easily inserted into your OneNote pages. If using Word or PowerPoint this is achieved from the Print window.

In contrast, when using Internet Explorer this is activated by clicking on **Tools** on the Toolbar at the top of the screen, and selecting **Send to OneNote**.

**Note:** Webpages may not display the same in OneNote as in Internet Explorer.

### Follow these steps:

1. Before beginning, ensure that you have a OneNote Notebook open in which the webpage, Word document, or PowerPoint presentation can be inserted. We will now consider how to insert slides from a PowerPoint Presentation.

   To begin, open PowerPoint. To do this in a PC Lab:

   - Click on **Start** at the bottom left of the screen.
   - Click on **PowerPoint** from the menu that displays.

2. Click on **File**.

3. Click on **Computer** at the bottom left of the **Open** window. Then click on the **Browse** button to display the **Open** dialogue box.

4. If necessary scroll down in the **left-hand** panel to display the list of available drives. Click on the (R:) drive in the list to select the drive and display its contents in the **right-hand** panel.

5. In the **right-hand** panel double-click on the **IT Training** folder to display its contents.

6. In the **right-hand** panel double-click on the **Demos** subfolder to display its contents.

7. Click on **Presentations.pptx** to select it. Then click on **Open** to open it.
**INSERTING IE, WORD OR POWERPOINT CONTENT (2)**

When wishing to insert Word documents or PowerPoint slides into a OneNote page you use the Print window to enable this.

**Follow these steps:**

1. Before beginning ensure that you have completed the previous page. We will now insert the PowerPoint Presentation we opened onto a OneNote page.
2. To begin, ensure that the PowerPoint presentation is displaying. We now need to Print this to OneNote.
3. Click on the **File** tab at the left of the **Ribbon**.
4. Click on **Print**.
5. Under the **Printer** heading click on the down-arrow to the right of the list of printers button. Select **Send to OneNote 2013** from the menu that displays.
6. Under the **Slides** heading click on the down-arrow to the right of the Slides button. Select the most suitable option for your need.
7. Click on the **Print** button at the top of the **Print** panel. If the **OneNote** button on the Task bar flashes, click on it to display OneNote.
8. When the **Select Location in OneNote** dialogue box displays click on **Minutes** under the **All Notebooks** heading. Then click on **OK** at the bottom of the dialogue box. The PowerPoint slides will be copied onto a new page within the **Minutes** section.
9. To complete the process replace OneNote’s suggested page title: Double-click on the **Printout** heading at the top of the page. Overtype this with the revised page title, which in this case is: **PowerPoint Slides**. Press [Enter] on the keyboard to move the cursor away from the title.
CREATING LINKS BETWEEN ONENOTE PAGES

To aid navigation around the notes you have created you can create links between the pages. This may be especially useful when your Notebook contains multiple pages and/or Sections.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.
2. We will now create a link between the Minutes for Meetings page in the Minutes section and the To Do List page in the Jobs section.
3. To begin, click on the Minutes tab at the top of the Notes area.
4. Then click on the Minutes for Meetings page at the top of the Page Tabs panel at the right of the screen.
5. To create a link to this page:
6. Right-click on the Minutes for Meetings page heading in the Page Tabs Panel on the right of screen.
7. Click on Copy Link to Page from the menu that displays.
8. To now create the actual link to this page:
9. Click on the Jobs tab at the top of the Notes area.
10. The To Do List page will display.
11. Click anywhere between the To Do List heading and the Current To Do List to obtain an insertion point.
12. Click on the Home tab at the left of the Ribbon.
13. Click on Paste in the Clipboard group at the left of the Ribbon.
14. The link to the Minutes for Meetings page will be pasted onto the page.
15. If you now click on this link the Minutes for Meetings page will immediately display.
CREATING LINKS BETWEEN A PARAGRAPH AND PAGE

In addition to creating links between OneNote pages (see previous page), you can also create them between a paragraph and a page. This enables a more targeted link to be created, and where required, could be used to create a table of contents.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.
   To examine the creating of links between text and a different page we will now create a link between the To Do List page and text on the Minutes for Meetings page that reminds us to write up some notes.
2. To begin, click on the Minutes tab at the top of the Notes area.
   Ensure that the Minutes for Meetings page is displaying.
3. Click anywhere on the page to obtain an insertion point.
   Type some suitable text, e.g.: Latest Meeting Notes
4. To create a link to this paragraph:
   Right-click on the text you just entered.
5. Click on Copy Link to Paragraph from the menu that displays.
6. To now create the link to this paragraph:
   Click on the Jobs tab at the top of the Notes area to display the To Do List page.
7. Click anywhere between the To Do List heading and the Current To Do List to obtain an insertion point.
8. Click on the Home tab at the left of the Ribbon.
   Click on Paste in the Clipboard group at the left of the Ribbon.
   The link to the Latest Meeting Notes paragraph will be pasted onto the page.
9. If you now click on this link the Latest Meeting Notes text will be displayed on the Minutes for Meetings page.
RENAMING LINKS

Once a link within OneNote has been created you can easily change the actual link’s text so that it is more meaningful.

Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will now modify the Latest Meeting Notes link so that it displays as: Write up Latest Meeting Notes.
2. To begin, click on the Jobs tab at the top of the Notes area to display the To Do List page.
3. Right-click on the Latest Meeting Notes link text.
4. Click on Edit link from the menu that displays to display the Link dialogue box.
5. Under the Text to display: heading modify the existing text (Latest Meeting Notes) to be: Write up Latest Meeting Notes
6. Click on OK to close the dialogue box and update the link.
**ADD NEW PAGES**

Pages can be easily added to any Section within your Notebook as and when necessary. Although by default pages can be very long, it is frequently useful to add a page when, for example, a new topic area is being created.

Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will now consider how to add a page to the Minutes Section.
2. To begin, click on the Minutes tab at the top of the Notes area.
3. To add a page to the Minutes Section:
   - Click on the Add Page button at the top of the Page Tabs panel at the right of the screen.
4. The new page will be added and displayed automatically.
5. To now enter this page’s title:
   - Ensure the insertion point is within the Title area at the top of the page.
6. Enter the page title, which in this case is: **Future Meetings**
   - You should notice that the new page is included in the Page Tabs panel at the right of the screen.
   - You should also notice that it uses the page title as the page name, and that it is highlighted in white.
7. If you now click on the Minutes for Meetings page in the Page Tabs panel it will be highlighted in white and the page opened on screen.
   - **Note:** The order that the pages display in the Page Tabs panel can be changed by clicking on one of the pages and dragging it up or down as required.
   - A black horizontal line indicates where the page will be positioned when the mouse button is released.
SEARCHING WITHIN THE NOTEBOOK (1)

Once your Notebook starts to become large it is likely that you will need to use OneNote’s Search facility to locate the notes you need to find. Although the Search panel is a very effective search facility, on its own its results can be problematic. This is because if you click anywhere on the Notebook the results may well be deselected, which frequently means the search having to be run again. To deal with this limitation it is recommended that the Search Results pane is always displayed, and used to access the results.

Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will now consider how to run a search for all occurrences of the word note within our Notebook.

2. To begin, click on the Jobs tab at the top of the Notes area to display the To Do List page.

3. Now click on the down-arrow to the right of the Search panel at the top right of the window.

   From the menu that displays select the most appropriate option.

   For example if All Notebooks is selected the search will be run on all currently open notebooks, and if This Section is selected all pages within the current section will be searched.

4. In this case select This Notebook.

5. Now enter the search word or phrase to be found:

   Click within the Search panel at the top right of the window.

   Enter the search term, which in this case is: note

6. All occurrences of the word note will be highlighted on the pages.

7. Before doing anything further, click on Pin Search Results (Alt+O) at the bottom of the Finished: This Notebook (change) panel.

   This displays the Search Results pane at the right of the window, and prevents the highlighted search results in the Notebook from being accidently deselected.

(Continued on next page.)
SEARCHING WITHIN THE NOTEBOOK (2)

Once the Search Results pane is displaying it can be used to view the search results without fear of them being deselected, and thus having to run the search again. The Search Results pane also includes the facility to re-run the search within a part of the Notebook (e.g. the current section) or all open Notebooks. You can also rearrange the results to display in Section order, date entered order, or by Page title.

Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will now modify the search results using the Search Results pane.
2. To begin, click on the down-arrow to the right of the Search Result’s lower pane.
3. Select Sort by Section from the menu that displays.
4. The search results are displayed under their Section names. Click on each link to view the results on ‘that’ page.
5. We will now further modify the results so that they display only the results for the current Section: To begin click on the down-arrow to the right of the Search Result’s upper pane.
6. Select Search This Section from the menu that displays.
7. The list of search results show those for only the currently selected section.
8. When you have finished using the search results close the Search Results pane by clicking on its Close button at its top right.
9. The majority of the highlighted search results within the Notebook will be deselected, and clicking anywhere on a white area will deselect the rest.

Note: By default the Search facility will include text within graphics wherever it can (this can be changed within OneNote’s Options).

If you find that some of the text within your graphics is not being included within the search results, it could be worth trying the Copy Text from Picture facility (see the page Extracting Text from Images).
**ADDING AND USING TAGS (1)**

In addition to using the Search facility (see previous page), you can also use the Tags facility to help locate the notes you are looking for.

OneNote includes a large number of Tags that can be applied to your notes, and by applying these in a structured way related notes can be easily and quickly retrieved.

---

**Follow these steps:**

1. **Before beginning ensure that you have completed the previous page.**
   We will now consider how to add several Tags to our Notebook.

2. **To begin, display the list of Tags included within OneNote:**
   Ensure that the **Home** tab at the left of the **Ribbon** is selected.

3. **Click on the More down-arrow at the right corner of the list of Tags in the Tags group towards the centre of the Ribbon.**

4. **View the list of Tags available.**
   When finished close the listing by clicking away from it.

5. **To begin adding Tags, click on the Jobs tab at the top of the Notes area to display the To Do List page.**

6. **To add the Important Tag to the Current To Do List:**
   Click anywhere within the Current To Do List heading of the bulleted list.

7. **Click on the Important Tag from the list of Tags in the Tags group towards the centre of the Ribbon.**
   A star displays to the left of the Current To Do List heading to show it has been tagged.

---

![First OneNote Notebook](image)
Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will now consider how to add several more Tags to our Notebook.

   To begin, add the **Important** Tag to the **Latest Meeting Notes** text:

   Click on the **Minutes** tab at the top of the Notes area and ensure the **Minutes for Meetings** page is displaying.

2. Click on the **Latest Meeting Notes** text towards the centre of the page.

3. Click on the **Important** Tag from the list of **Tags** in the **Tags** group towards the centre of the **Ribbon**.

   A star displays to the left of the text to show it has been tagged.

4. Now add the **Question** Tag to the text you previously extracted from the graphic using **Screen Clipping**:

   Click anywhere within the first line of the text.

5. Click on the **Question** Tag from the list of **Tags** in the **Tags** group towards the centre of the **Ribbon**.

   A question mark displays to the left of the text to show it has been tagged.

6. To now use these Tags to access the content:

   Click on **Find Tags** in the **Tags** group towards the centre of the **Ribbon**.

7. The **Tags Summary** panel displays at the right of the screen displaying the three areas of content we have Tagged.

8. Now view the content by clicking on the text to the right of each Tag.

   When you have finished close the **Tags Summary** panel by clicking on its **Close** button.
**ADDING TO DO TAGS**

Another Tag included within the list of Tags (see previous two pages) is the To Do Tag. In addition to Tagging the content so that it displays within the Tags Summary panel, this Tag adds a check box so that you can tick off the To Do list as you complete it.

**Follow these steps:**

1. Before beginning ensure that you have completed the previous page. We will now consider how to add To Do Tags to the Current To Do List.
2. To begin, click on the Jobs tab at the top of the Notes area to display the To Do List page.
3. Although we could remove the existing bullet points within the Current To Do List, in this case we will keep them and just add the To Do Tags. To begin this click and drag across the three bulleted items in the list to select them.
4. Ensure that the Home tab at the left of the Ribbon is selected. Click on the To Do Tag from the list of Tags in the Tags group towards the centre of the Ribbon. A check box displays to the left of each bulleted item.
5. Now click on the check box for two of the bulleted items. You should see that a red tick mark is added to them, which enables their status to be easily identified.
6. To view these Tags in the Tags Summary panel: Click on Find Tags in the Tags group towards the centre of the Ribbon. You should notice that the To Do Tags in the Tags Summary panel also display the two tick marks. Now click on the un-ticked bulleted item in the To Do list so that it displays a red tick mark.
7. You should notice that the Tags in the Tags Summary panel do not update to show this tick. To rectify this, click on Refresh Results at the bottom of the Tags Summary panel.
8. When you have finished close the Tags Summary panel by clicking on its Close button.
**USING HANDWRITING TO ENTER NOTES**

If you are using a tablet, smartphone, laptop, or computer with a touch-sensitive screen you can enter your notes, and make drawings, by writing directly on screen (a suitable stylus may be required).

Additionally, OneNote includes the facility to convert Handwriting into text.

---

**Follow these steps:**

1. We will now consider how to activate the Handwriting facility.
2. To begin, click on the **Draw** tab towards the centre left of the **Ribbon**.
3. Click on one of the Pen options in the **Tools** group towards the centre left of the **Ribbon**.
   
   You should notice that the **Type** button at the left of the **Ribbon** is no longer purple. This indicates that the usual keyboard and mouse mode has been replaced with the writing and drawing mode.

4. You can now use a stylus (or possibly your finger) to write or draw on a touch-sensitive screen.

5. Alternatively, you can use the mouse to write or draw when not using a touch-sensitive screen.

6. **To erase handwritten notes or drawings:**
   
   Click on the **Eraser** button in the **Tools** group at the left of the **Ribbon**. Using the stylus, your finger, or the mouse wipe across the unwanted content until it is removed.

   To turn off the Eraser, click on one of the Pen options in the **Tools** group, or click on the **Type** button at the left of the **Ribbon**.

7. **Note:** To return to the keyboard and mouse mode at any time click on the **Type** button at the left of the **Ribbon**.

8. **To convert handwritten notes into text:**
   
   Ensure that the **Draw** tab at the centre left of the **Ribbon** is selected. Also ensure that the **Type** button at the left of the **Ribbon** is selected.

   Select the handwritten notes to be converted by clicking and dragging across them.

   Click on the **Ink to Text** button in the **Convert** group at the right of the **Ribbon**.

   As long as OneNote can read the notes they will be converted to editable text.

   Do remember to **very carefully** proofread the editable text in case OneNote has produced poor results!
**SHARING ONE NOTEBOOKS (1)**

OneNote Notebooks can be shared with your other computers, laptop, iPad etc. They can also be shared with other people, which enables you/others to both view and modify the Notebook at the same time. To be able to share a Notebook with your other computers etc. it can be saved to your (Y:) drive (which is accessible by only you).

For others to also access a Notebook you need to be using Office 2013 and the Notebook needs to be saved to a drive or location that enables sharing, for example your OneDrive, which is part of your College e-mail account. Once saved to there you can share the Notebook with any other member of the College.

---

### Follow these steps:

1. We will now consider how to share our OneNote Notebook by first copying it to a sharable drive, which in this case is our OneDrive. To begin we need to first ensure that our OneDrive is accessible. To do this:

2. Click on **File** at the left of the **Ribbon**. Then click on **Share** in the menu on the left.

   Ensure that **OneDrive – Royal Holloway University of London** displays in the right-hand panel.

3. **If it does**, move on to the next page. **OR**

   **If it does not** proceed with the following steps:

4. Click within your name at the top-right corner of OneNote.

5. Click on **Switch account** to display the **Accounts** dialogue box. Then click **Add Account**.

   In the **Type your email address or phone number** panel:

   **If a student** enter your **College** e-mail address in the format **username@live.rhul.ac.uk** (e.g. zbaa666@live.rhul.ac.uk).

   **If a staff member** enter your College e-mail address, e.g. ann.nonymouse@rhul.ac.uk

6. Then click **Next**.

   If the **We Need a Little More Help** dialogue box displays click on **Work account**.

7. The **Sign In** dialogue box displays with your e-mail address already entered.

   Now enter your password into the **Password** panel. Then click on **Sign in**.

8. After a short delay you should notice that **OneDrive – Royal Holloway University of London** displays in the right-hand panel, showing that your College OneDrive is now accessible.
**SHARING ONE NOTEBOOKS (2)**

Saving to a sharable drive or location can be done either when the Notebook is first created or at any point during its use. It should be remembered that when saving a Notebook to a sharable drive **only** the version

On the shared drive will continue to be updated. As a result the original version, in this case, the one saved to the (Y:) drive, will no longer be updated with any changes.

---

**Follow these steps:**

1. Before continuing ensure you have completed the previous page.
   We will now save our OneNote Notebook to our OneDrive.

2. To begin click on **OneDrive – Royal Holloway University of London** at the left of the main window.

3. Then click on **Browse** that displays to the right of the main window.

   The **Move Notebook** dialogue box displays which shows the content of your OneDrive.

   **Note:** If your OneDrive content does not display close the dialogue box, wait a minute and then click **Browse** again.

4. If you want to save the Notebook to a folder double-click on it within the **right-hand** pane.

5. In the **Notebook Name:** panel enter a name for this version of your Notebook.
   Then click **Move**.

6. When the **Microsoft OneNote** dialogue box displays click **OK** to complete the copying to your OneDrive and make the Notebook sharable.

7. Click on the back-arrow at the top-left of the window to return to your OneNote Notebook.
SHARING ONE NOTEBOOKS (3)

Once your OneNote Notebook has been saved to your OneDrive it can be easily shared with others who have access to a OneDrive account, which includes other members of College.

Note: At present staff cannot share with students, only other staff members and externals with a OneDrive account. In contrast students can share with staff members as well as other students and externals.

Follow these steps:

1. Before continuing ensure you have completed the previous page.
   We will now consider how we can share our OneNote Notebook with another member of College.

2. Click on File at the left of the Ribbon

3. Then click on Share in the menu on the left.

4. In the Type name or e-mail address panel enter the e-mail address of the person you wish to share your OneNote Notebook with.

5. Click on the down-arrow to the right of the Type name or e-mail address panel. Then select Can edit or Can view to set the permission level you wish to grant.

6. The person will receive an e-mail informing them that they now have access to your OneNote Notebook. Therefore, in the Include a personal message with the invitation panel enter an explanation of why the recipient is receiving access to this Notebook.

7. Click on the Share button towards the bottom of the main window. The e-mail will be sent to the recipient, which includes a hyperlink to the Notebook. When this is clicked on it opens the online version of OneNote for them to use.

8. To open the Notebook in the full version of OneNote (as long as it is installed):
   Click on File at the top-left to display the Info window.
   Click on Open in OneNote.

9. If still viewing OneNote’s Share Notebook window click on the back-arrow at the top-left of the window to return to your OneNote Notebook.
BACKING UP YOUR ONE NOTE NOTEBOOKS

By default OneNote automatically backs up your Notebooks once per day. However this is probably to the (C:) drive on the computer being used.
As OneNote automatically saves changes to your Notebooks it is possible that you may need to use these backups at some point, for example to retrieve content that you have accidentally deleted or overwritten.
As a result, it may be wise to change the default setting to save to your (Y:) drive, and to produce them more regularly.

Note: These settings apply only to the computer being used. Therefore they will need to be applied to any other computer on which you use your Notebook(s).

Follow these steps:

1. We will now consider how to modify the default backup settings by changing them to save to our (Y:) drive every 30 minutes, and to keep 5 backup copies.
2. To begin, click on the File tab at the left of the Ribbon. Then click on Options at the bottom of the menu that displays.
3. In the left panel of the OneNote Options dialogue box click on Save & Backup.
4. Under the Save heading click on Backup Folder from the list of options. Then click Modify.
5. In the Select Folder dialogue box that displays scroll down in the left-hand panel to display the list of available drives.
   Then, in this case, click on your (Y:) drive.
   Note: Doing this assumes you have connectivity to this drive whenever using OneNote.
6. If you wish to save the backups to a folder on the (Y:) drive locate it in the right-hand panel and click on it to select it.
   Click on Select at the bottom of the dialogue box to close it and select the drive.
   To perform the backups more often:
   Immediately below the Backup heading click on the down-arrow to the right of the panel. Then select 30 minutes (or a more appropriate time for your needs).
   To keep e.g. 5 backup copies for each Notebook:
   To the right of the Number of backup copies to keep: panel click on the up/down arrows until 5 displays (or a more appropriate number for your needs).
7. When finished click on OK to close the OneNote Options dialogue box.
8. If the Microsoft OneNote dialogue box displays stating that you need to restart OneNote, click on OK.
   Then restart OneNote if you wish the changes to begin immediately.
PASSWORD PROTECTING A SECTION

To enable Notebooks to be protected from inadvertent or unauthorised viewing or changes, OneNote includes the facility to password protect each Section individually. Although the whole Notebook cannot be protected in one stage, each Section can be protected with the same password.

Follow these steps:

1. Before beginning ensure that your OneNote Notebook is open on screen. We will now examine how we can apply password protection to our Notebook.

2. To begin, right click on the Minutes tab at the top of the Notes area.

3. Click on Password Protect This Section from the menu that displays. The Password Protection Task Pane displays to the right of the window.

4. Click on Set Password below the Current Section heading.

In the Password Protection dialogue box that displays enter the password you wish to use into both the Enter Password: and Confirm Password: panels. Click on OK to close the dialogue box and set the password.

5. If the Existing Section Backups dialogue box displays stating that backup copies exist for ‘this’ section that will not be protected, click on Delete Existing Backups or Keep Existing Backups as appropriate for your needs.

Note: If this password is lost you will not be able to access the section, therefore it is recommended that you ensure you do not forget/lose the password AND have a non-protected backup version of the Notebook.

6. If you wish to protect other sections repeat steps 2 to 5.

7. When finished close the Password Protection Task Pane by clicking on its Close button at its top right.
UNLOCKING A PASSWORD PROTECTED SECTION

Once a section has been password protected it will be protected each time the Notebook is opened, or after 10 minutes (default time) of non-use. To then be able to view or modify the section its password will need to be entered.

Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will now examine how to unlock our password protection Minutes section.

2. By default the protected section(s) will be locked after 10 minutes of non-use.

3. To protect the Notebook immediately at any time click on **Lock All** in the centre of the **Password Protection** Task Pane.

   Alternatively, if the **Password Protection** Pane is not displaying:

   On the keyboard press: 
   
   **[Ctrl] + [Alt] + [L]**

   **Reminder:** This is **L** for lock.

4. **To Unlock a Protected Section:**

   In this case click on the **Minutes** tab at the top of the Notes area. The **Minutes** section’s page displays that it is Password protected.

5. Either click within the page or press **[Enter]** on the keyboard.

6. When the **Protected Section** dialogue box displays enter the section’s password. Then click on **OK** to close the dialogue box and unlock the section.
E-MAILING A PDF COPY OF A ONE NOTE NOTEBOOK (1)

In addition to sharing a Notebook (see page 28) and e-mailing a selected page (see page 36), another way of giving other people access to a Notebook is to e-mail them a PDF version. To do this in OneNote you use the Export option, rather than the more usual Save As. This enables a PDF to be produced of the whole Notebook, a particular section, or particular page.

Follow these steps:

1. We will now consider how to produce a PDF version of one of the Sections in our Notebook. Before starting ensure that one of the pages within the Section that you wish to PDF is displaying.

2. Click on File at the left of the Ribbon.

3. Click on Export from the menu on the left.


5. Under the 2. Select Format: heading select: PDF (*.pdf)

6. Click on the Export button towards the bottom of the window. The Save As dialogue box displays.

7. If necessary scroll down in the left-hand panel to display the list of available drives. Click on your (Y:) drive in the list to select the drive and display its contents in the right-hand panel.

8. In the File name: panel enter a suitable name for this PDF version of your Notebook.

9. Click on [Save] to create the PDF version.
E-MAILING A PDF COPY OF A ONE NOTE NOTEBOOK (2)

Once a PDF version of a OneNote Notebook has been produced you can use Adobe Reader to e-mail it to colleagues, lecturers etc.

Follow these steps:

1. Before starting ensure that you have completed the previous page.
   We will now use Adobe Reader to consider how the PDF version can be e-mailed. Before beginning ensure that Outlook has been opened.

2. To open Adobe Reader in a PC Lab:
   Click on the Start button at the bottom-left of the screen.
   Click on All Programs at the bottom of the menu that displays.
   Click on Current Applications from the menu that displays.
   Click on Adobe.
   Then click on Adobe Reader XI to display Adobe Reader.

3. To open the PDF file:
   Click on File at the top-left of the window.
   Then select Open at the top of the menu that displays to show the Open dialogue box.
   If necessary scroll down in the left-hand panel to display the list of available drives.
   Click on your (Y:) drive in the list to select the drive and display its contents in the right-hand panel.

4. In the right-hand pane locate the PDF version of your Notebook.
   Then double-click on it to open it.

5. To e-mail the PDF version of the Notebook:
   Click on File at the top-left of the window.
   Click on Send File.

6. In the Send Email dialogue box that displays ensure that the Default email application (Microsoft Outlook) check box contains a check mark.

7. Click on the Continue button at the bottom of the dialogue box.
   A New Message e-mail window displays with the PDF file included as an attachment. You can then enter the intended recipient’s e-mail address and send the e-mail.
SENDING OneNote pages as an Outlook E-mail

It is easy to send a OneNote page as an e-mail as long as you have Outlook running on the same computer as you are using OneNote. This can be useful, for example, if you are using OneNote to record meeting minutes, as you can then e-mail them to all those who attended.

Follow these steps:

1. We will now consider how to send a OneNote page as an e-mail.
2. To begin, ensure that Outlook is running (and that it was opened before OneNote, otherwise the Outlook buttons will not display on OneNote’s Ribbon).
3. Also ensure that the OneNote page that you wish to e-mail is displaying. In this case this can be any page of your choice.
4. Ensure that the Home tab at the left of the Ribbon is selected.
5. Then click on the Email Page button in the Email group at the right of the Ribbon. A New Message window displays containing the information from the OneNote page.
6. Modify the e-mails contents if necessary. Then ensure that the Subject: panel contains the correct content.
7. Enter the e-mail’s recipient(s) in the normal way by entering them or using the Global Address List.
8. Once you are ready click on Send to send the e-mail.
**INSERTING DETAILS FROM OUTLOOK MEETINGS/APPTS**

If you are using OneNote to take notes on a meeting that is already in your Outlook calendar you can avoid manually entering the meeting’s details such as date, time, and attendees by inserting them directly from Outlook.

**Follow these steps:**

1. We will now consider how to include the date, time and attendee details into a OneNote page from a meeting already entered into our Outlook Calendar.

   **Note:** To enter meetings from another person’s Calendar you will need to setup Outlook with a Profile that allows you to open ‘their’ Calendar.

2. To begin, ensure that Outlook is running (and that it was opened **before** OneNote, otherwise the Outlook buttons will not display on OneNote’s Ribbon).

3. Click on the **Minutes** tab at the top of the Notes area and ensure the **Minutes for Meetings** page is displaying.

   Then click anywhere within a blank area to obtain an insertion point.

4. To begin automatically inserting the meeting’s details:

   Ensure that the **Home** tab at the left of the **Ribbon** is selected.

5. Click on the **Meeting Details** button at the right of the **Ribbon**.

   If the meeting to be minuted is listed on the menu that displays, click on it to insert the details into OneNote.

6. If the meeting is not listed, click on **Choose a Meeting from Another Day** at the bottom of the menu.

   Then use the **Back** and **Forward** arrows to the left of the date to locate the relevant meeting.

7. When the correct meeting is found, click on it to select it.

   Then click on **Insert Details** at the bottom of the dialogue box.

8. The meeting’s details will be inserted into the OneNote page.

   These can be edited if necessary e.g. deletion of those who do not attend.

9. If the meeting’s details are not inserted where you want them to be:

   Click within the details to display its border.

   Point to its wide top border so that the cursor changes to a four-headed arrow, then drag the Note Container to where you want it.
**INSERTING LINKS TO OUTLOOK MEETINGS/APPTS (1)**

You can create a link within OneNote to Meetings and Appointments within Outlook. When this link is clicked on the Appointment or Meeting opens in Outlook for you to view or modify.

**Follow these steps:**

1. We will now consider how to include a link within our OneNote page that displays a specific meeting or appointment from our Outlook Calendar. Doing this enables notes about the meeting to be entered into OneNote, and have an easy link to the actual meeting in Outlook.

2. To begin, ensure that Outlook is displaying.

3. Then open the Meeting or Appointment to which you want to create the link within OneNote.

4. Ensure that the **Meeting** or **Appointment** tab at the left of the **Ribbon** is selected.

5. Then click on the **Meeting Notes** button in the **Meeting Notes** group at the centre of the **Ribbon**.

6. In the **Meeting Notes** dialogue box that displays select either **Share Notes with the meeting** or **Take Notes on your own** as appropriate. If **Share Notes with the meeting** is selected all attendees will be able to contribute to the notes, however the Notebook will need to be saved to OneDrive and sharing with them enabled.

7. In this case select: **Take Notes on your own**.
**INSERTING LINKS TO OUTLOOK MEETINGS/APPTS (2)**

Follow these steps:

1. Before continuing ensure you have completed the previous page.

2. When the **Select Location in OneNote** dialogue box displays:
   - If multiple Notebooks are displayed under the **All Notebooks** heading, click on the plus sign to the left of the one you wish to use, to display its Sections.

3. In this case click on the plus sign to the left of the **First OneNote Notebook**.

4. Then select the **Minutes** section.

5. Click on **OK** to close the **Select Location in OneNote** dialogue box.

6. If it is not already displaying, return to OneNote by clicking on its button on the Taskbar.
   - Ensure the **Minutes** section is selected.

7. You should see that a new page has been created which has the same page name and page heading as the Meeting/Appointment’s Subject.

8. This new page contains the Meeting or Appointment’s details, including a link to it in Outlook.

![Select Location in OneNote](image1)

![First OneNote Notebook](image2)

![Minutes section](image3)

![Meeting details](image4)
CREATING AN OUTLOOK TASK FROM ONE NOTE CONTENT

OneNote includes the option to create Tasks in Outlook. When doing this, if Outlook is not running OneNote will attempt to connect with Outlook and create the Task the next time OneNote is re-opened.

Follow these steps:

1. We will now consider how to create an Outlook Task from some of the content on one of our OneNote pages.

   To begin, ensure that Outlook is running.

   **Note:** If Outlook is not running OneNote will attempt to connect with Outlook and create the Task the next time it is opened.

2. Display the OneNote page that contains the text you wish to make into a Task. Then right-click within the text that the Task is to be linked to. In this case this can be any text of your choice.

3. From the mini-toolbar that displays, click on the down-arrow to the right of the Task flag at its top right.

4. From the menu that displays select one of the preconfigured options, e.g. Today, Tomorrow, This Week. The Task will be created in Outlook that includes a link to the OneNote Notebook, and a flag displayed to the left of the OneNote text.

5. Alternatively, click on Custom from the menu that displays to open a **New Task** window. This will enable you to select the Start date:, Due date:, Status: etc. in the normal way when creating a Task. When finished click on **Save and Close** at the left of the **Ribbon** to close the **New Task** window.

6. If OneNote is not displaying, return to it by clicking on its button on the Taskbar.
CLOSING & Opening OneNote Notebooks

Unlike when using Word, Excel, etc., each time OneNote is opened it automatically opens the last Notebook to be used.

However, a Notebook can be closed at anytime should you need to, for example to change to another one.

Follow these steps:

1. We will now consider how to close our OneNote Notebook.
   To begin, ensure that your OneNote Notebook is displaying on screen.

2. **To close a Notebook:**
   Right-click on the Notebook’s name in the Notebook Navigation Bar at the left of the screen.

3. From the menu that displays select **Close This Notebook**.

4. **To Open a Notebook:**
   Click on the **File** tab at the left of the **Ribbon**.

5. Click on **Open** from the menu that displays

   If the Notebook has been recently used click **Recent Notebook** at the centre left **Section** tabs.
   Then select the required Notebook from the listing under the **Recent Notebook** heading on the right.

   If the Notebook has **not** been recently used click on **Computer** under the **Open from other locations** heading at the centre left of the window.
   Then click on the **Browse** button at the bottom right of the window.

   Navigate to the drive and folder(s) in the normal way.
   **Note:** Notebooks are saved to a **folder** that has the same name as that given to the Notebook when it was created.
   Within this folder it is the **Open Notebook.onetoc2** file that should be used to open the Notebook.

---

![First OneNote Notebook](image1)

![Open Notebook](image2)
COPYING EXISTING NOTES TO ONENOTE (1)

Once you have been using OneNote for a while it is likely you may wish to copy your previous notes into OneNote in order to have them all stored in one location.

To achieve this there are several facilities available to help, depending on the format the notes are currently in.

Follow these steps:

1. **To copy handwritten notes into OneNote:**
   Handwritten notes will need to be scanned into an electronic format (e.g. .JPG or PDF).
   This can be done using a personal scanner, departmental MFD, or MFD in the PC Labs, Libraries, or Computer Centre.
   **Note:** It is unlikely that handwritten notes will be included in any searches that are run on the Notebook.

2. See the next page for details on how to insert the electronic version of your notes into OneNote.

3. **To copy printed notes to OneNote where the electronic file does not exist:**
   If the notes are in printed format but you do not have them as an electronic file they can be scanned on one of the MFDs, or a personal scanner in e.g. .JPG or PDF format.
   Once inserted into OneNote this can then be made editable (where possible) using OneNote’s Extracting text from Images facility.
   Alternatively, the designated PCs in the PC Lab can be used to access OmniPage (OCR application) to convert the scanned image in to editable text.

4. See the next page for details on how to insert these files into OneNote.

5. **Copying notes to OneNote where an electronic file exists (e.g. a Word document):**
   Where an electronic file exists, e.g. a Word file, it can be inserted into OneNote using the methods covered on the next page.
COPYING EXISTING NOTES TO ONE NOTE (2)

To copy files into OneNote you can either use the Insert method as covered on Page 16, or drag the file from Windows Explorer or Computer (previously My Computer) directly into OneNote.

In order to examine how to drag a file into OneNote we will use the PowerPoint presentation we previously used on Page 16.

Follow these steps:

1. To begin, click on an appropriate page within your OneNote Notebook that is to contain the presentation.
   Then click on OneNote’s Restore Down button at the top right of its window. OneNote will display as a smaller window.

2. Now open Computer (previously My Computer) in order to locate the file to be dragged into OneNote:
   Click on the Start button at the bottom left of the screen.
   Click on Computer on the right side of the menu that displays.

3. In the Computer’s left-hand panel click on the (R:) drive to select the drive and display its contents in the right-hand panel.
   In the right-hand panel double-click on the IT Training folder to display its contents.

4. In the right-hand panel double-click on the Demos subfolder to display its contents.

5. Click on the Computer’s Restore Down button so that it displays as a smaller window.

6. Now move OneNote to be alongside the Computer’s window:
   Move the Computer and OneNote windows so that they are roughly side-by-side, by clicking on their Title bars and dragging them into place.

7. Within the Computer’s right-hand panel, locate the file you wish to drag to OneNote, which in this case is Presentations.pptx.
   Then drag the file to the appropriate page in OneNote.

8. If the Insert File dialogue box displays, click on Insert Printout.
   The notes, in this case presentation, will be inserted into the OneNote Page.

9. When you have finished close the Computer window by clicking on its Close button at the top right of its window.
   Then Maximise OneNote’s Window by clicking on its Maximise button at the top right of its window.
ACCESSING THE IT TRAINING EXERCISE FILES FROM YOUR OWN PC/LAPTOP

In order to access the files required to complete many of the IT Training exercises you need to access a shared drive, referred to as the (R:) drive in the notes. These instructions give details on how to connect to this drive, for example from your home, along with details on how you can also set up access to your (Y:) drive.

Important: If your PC already has an (R:) drive/(Y:) drive you will need to select a different letter in the following instructions.

Follow these steps:

Note: If using a Mac, instructions on setting up Campus Anywhere (VPN) can be found at: http://www.rhul.ac.uk/IT/CampusAnywhere/
Instructions on mapping to the (R:) drive and (Y:) drive can be found at:
http://www.rhul.ac.uk/it/faq/itfaqs/mac/mapnetworkdrive.aspx

If working on Campus ensure that you are connected to the network (if using an office computer) or CampusNet (if using a laptop etc.).

OR

If working off Campus ensure that you are connected to the Internet and that you have connected to Campus Anywhere (VPN).
Note: To obtain instructions on how to set up Campus Anywhere (VPN) visit:
http://www.rhul.ac.uk/IT/CampusAnywhere/

Display My Computer or Computer. To do this:
Press the Windows key at the right of the keyboard and with it still depressed press E on the keyboard.

1 OR

Click on Start and then click on Computer at the right of the Start menu.

To map to the (R:) drive:
Click on Tools.

3 Select Map network drive to open the Map Network Drive dialogue box.
Click on the drop-down arrow to the right of the Drive: panel and select R: (or any letter of your choice if that already has an entry, and so already allocated).

In the Folder: panel enter the mapping for the (R:) drive which is:
\ourdata.rhul.ac.uk\teaching\PCLabs
Ensure that the Reconnect at logon box displays a tick mark. If it does not, click within it so that it displays one.

4 Click on [Finish] to complete the setting up. You should now be able to see the (R:) drive containing the IT Training files.

To map to your (Y:) drive:

6 You can map to your (Y:) drive as covered in steps 3, 4 & 5 but note the following:
   a) If your PC already has a (Y:) drive you will need to select a different letter in step 3.
   b) In step 4 the path that you must enter is: \mydata.rhul.ac.uk\home

Note: When accessing these drives you may be prompted for your username and password. If this occurs you must prefix your username with cc\ For example, if your username is zhaa666 then you must enter cc\zhaa666

7 When finished close the My Computer dialogue box by clicking on its Close button.
   If a My Computer window is still displaying also close it by clicking on its Close button.